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WS3: Modelling Multi Species Flow

Customer Training MaterialIntroduction (1)
In this workshop you will analyze the release of heat and combustion 
gases from a single car with an engine fire in a ventilated parking garage. 
The simulation will be run as a steady state analysis assuming the fire 
has reached a stable developed stage. 
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WS3: Modelling Multi Species Flow

Customer Training MaterialIntroduction (2)
• Simulation Physics & Boundary Conditions
– Mixture of N2, O2, CO2 and H20
– 6 m/s exhaust– 6 m/s exhaust
– 80 N/m3 momentum source in jets
– 0.1 kg/s flue gases (H2O and CO2) at 1200 K

k il b l d l– k-epsilon turbulence model
– DO radiation model with WSGGM for absorption coefficient
– 300 K inlet temperature

Fresh Air Inlet 
‘pressure_inlet‘ 

Jet Fan 

Symmetry Plane 
‘symmetry‘

‘fluid_jet‘

Heat and gas release from 
engine bay
‘mass-flow-inlet-flue gas‘Air Outlet

WS3-3
ANSYS, Inc. Proprietary
© 2010 ANSYS, Inc.  All rights reserved.

Release 13.0
December 2010

mass flow inlet flue_gasAir Outlet 
‘inlet_exhaust‘



WS3: Modelling Multi Species Flow

Customer Training MaterialGoals
• This Workshop will demonstrate how to:
– Set up a case with multiple species
– Define absorption coefficient for flue gases– Define absorption coefficient for flue gases
– Define gravity and operating conditions for buoyancy driven flows
– Define volumetric sources

Ch l i d b d di i d i h l l i– Change solver settings and boundary conditions during the calculation
by using calculation activities

– Judge solution convergence using monitors
– Postprocess a case with multiple species
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WS3: Modelling Multi Species Flow

Customer Training MaterialPreparation
• Files
– Copy the following files to your working directory.

– garage msh– garage.msh
– calc_activities.jou
– multi-species-solved.wbpz
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WS3: Modelling Multi Species Flow

Customer Training MaterialStarting Workbench

• Open Workbench
– Start > Programs > ANSYS 13.0 > ANSYS Workbench

Drag a FLUENT Component System into the project schematic– Drag a FLUENT Component System into the project schematic
– Rename the system to ‘Garage’ (RMB on cell A1 to rename the 

system)
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WS3: Modelling Multi Species Flow

Customer Training MaterialUser Files Directory
• Manage External Files
– This project requires the import of existing files. Workbench creates a 

directory named ‘User Files’ where files created externally can bedirectory named User Files  where files created externally can be 
stored and associated with the project.
– This enables Workbench to synchronise projects with external files.

– From the Workbench project page save the project to your working– From the Workbench project page save the project to your working 
directory using the name “multi-species”.
– The ‘user_files’ directory will be found in the project files directory.

– Copy the two files “garage.msh” and “calc_activities.jou” to this 
directory. All files associated with the project are listed when the 
Files option is checked from the Workbench View menu.
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WS3: Modelling Multi Species Flow

Customer Training MaterialStarting FLUENT in Workbench

• Start FLUENT
– Double click on the Setup cell to open FLUENT

Choose 3D and Double Precision under Options and retain the– Choose 3D and Double Precision under Options and retain the 
other default settings (if your computer has 2 or more nodes and 
parallel licenses are available, you also could start FLUENT 
parallel)parallel)
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WS3: Modelling Multi Species Flow

Customer Training MaterialImport Mesh and General setup
• Import the existing mesh file
– Under the Fluent File menu select Import > 

Mesh.Mesh.
– Select the file ‘garage.msh’ and click OK to 

import the mesh.
– To check for any problems in the mesh click– To check for any problems in the mesh click 

Check. There should be no problems 
reported in the TUI window.

– Reorder the mesh using Mesh > Reorder > 
Domain (from the menu).
– Reordering the domain can improve the– Reordering the domain can improve the 

computational performance of the solver by 
rearranging the nodes, faces and cells in memory.

– Retain defaults for the solver
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WS3: Modelling Multi Species Flow

Customer Training MaterialSetting Physics (Turbulence)
• Specify turbulence model
– Select Models in the navigation pane.
– Double click Viscous in the model– Double click Viscous in the model 

selection pane. The Viscous Model 
panel will open.

– Select k-epsilon (2 eqn) under Model– Select k-epsilon (2 eqn) under Model, 
Standard under k-epsilon Model and 
Enhanced Wall Treatment under Near-
Wall Treatment. 
– Turbulence modelling, as with all physics 

modelling, is a complex area. There are 
many application specific options. The 
standard k-epsilon model is a simple butstandard k-epsilon model is a simple but 
robust model. The documentation provides 
further guidance on which models to use for 
specific applications. 

Cli k OK
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WS3: Modelling Multi Species Flow

Customer Training MaterialSetting Physics (Radiation)
• Specify radiation model
– Double click Radiation in the model selection pane. The Radiation Model panel 

will open.
– Select Discrete Ordinates (DO) under Model.
– Set Flow Iterations per Radiation Iteration to 1 and click OK.

– ANSYS FLUENT provides five radiation models. The DO model spans the entire range of 
ti l thi k d ll t l bl i f f t f di ti

You will be informed, that material properties or 
methods have changed. The Text User Interface 
(TUI) will list new material properties required for  
radiation  modelling. Click OK. Material 
properties will be defined later

optical thicknesses, and allows you to solve problems ranging from surface-to-surface radiation 
to participating radiation in combustion problems.

properties will be defined later.

Note also that the energy equation is switched on 
automatically when any heat transfer related 
physics are requested.
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WS3: Modelling Multi Species Flow

Customer Training MaterialSetting Physics (Species / Mixture)
• Specify species model
– Double click Species in the model 

selection pane. The Species Modelselection pane. The Species Model 
panel will open.
– In this workshop the products of 

combustion (heat & gases) will be 
modelled rather than the reaction itself.

– Select  Species Transport and click 
OK. 
– Switching on the species model will, as 

with the radiation model, introduce new 
material properties.  An information 
box will appear Click OK to acceptbox will appear. Click OK to accept 
this. 

– This setup will enable the tracking of 
non-reacting chemical species

The species model requires the definition 
of a ‘mixture’ representing the chemical 
species of interest. The default mixture 
contains nitrogen, oxygen and water 
vapour.
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WS3: Modelling Multi Species Flow

Customer Training MaterialDefining Materials (1)
• Specify mixture
– Select Materials in the navigation 

pane.pane.
– Note that under Mixture in the Materials 

pane the default mixture is listed as 
containing nitrogen, oxygen and water-
vapourvapour.

– Double click mixture-template,  this will 
open the Create/Edit Materials panel  
with the mixture preselectedwith the mixture preselected.  
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WS3: Modelling Multi Species Flow

Customer Training MaterialDefining Materials (2)
• Add a mixture species
– In the Create/Edit Materials panel click 

on FLUENT Database.on FLUENT Database.
– The FLUENT Database Materials panel will 

appear.

– Select Fluid as Material Type.
– All predefined fluids materials will be listed 

under FLUENT Fluid Materials.

– Select carbon-dioxide (co2).
– Click Copy.

– The TUI will inform you that carbon-dioxide 
has been added.

Cl th FLUENT D t b M t i l– Close the FLUENT Database Materials 
panel.
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WS3: Modelling Multi Species Flow

Customer Training MaterialDefining Materials (3)
• Add a mixture species
– Copying carbon-dioxide(co2) from the fluid database has made the 

species available to the simulation, now add it to the mixture.species available to the simulation, now add it to the mixture.
– In the Create/Edit Materials panel ensure Material Type is set to Mixture and click 

the Edit button for the Mixture Species.
– In the Species panel select co2 from the Available Materials list and use the Add 

b tton to add it to the Selected Species list The Selected Species defines thebutton to add it to the Selected Species list. The Selected Species defines the 
component species of the mixture. 

– The order of the species listed under Selected Species is important. The most 
abundant species should be listed last. Use the Remove button to remove n2 
followed by the Add button to replace n2 as the last species. Click OK.
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WS3: Modelling Multi Species Flow

Customer Training MaterialDefining Materials (4)
• Specify mixture
– Modify the existing settings for Thermal Conductivity, Viscosity and 

Absorption Coefficient as shown below. Click Change/Create to applyAbsorption Coefficient as shown below. Click Change/Create to apply 
the changes.
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WS3: Modelling Multi Species Flow

Customer Training MaterialDefining Materials (5)
• Specify solid material
– Select Solid under Material Type (The default solid material is aluminum(al)).

– Modify aluminum (Name Chemical Formula & Properties) as shown– Modify aluminum (Name, Chemical Formula & Properties) as shown 
below.

– Click Change/Create and choose No for overwriting. Close the 
Create/Edit Materials panelCreate/Edit Materials panel.
– Selecting No preserves the original material (aluminum) and adds the new modified 

material. 
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WS3: Modelling Multi Species Flow

Customer Training MaterialCell Zone Conditions (1)
• Set cell zone conditions
– Select Cell Zone Conditions from the Navigation Pane.
– Double click fluid jet from the Zone list– Double click fluid_jet from the Zone list.
– Activate Source Terms.
– Select the Source Terms tab and click on Edit for Y Momentum.

Add 1 l C d l f 80 ( / 3)– Add 1 source, select Constant and enter a value of -80 (n/m3)
– Click OK in both panels.
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WS3: Modelling Multi Species Flow

Customer Training MaterialBoundary Conditions (exhaust 1)
• Set boundary conditions
– Select Boundary Conditions from the Navigation Pane.
– Double click inlet exhaust from the Zone list– Double click inlet_exhaust from the Zone list.
– Apply Momentum settings as shown.
– Click OK.
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WS3: Modelling Multi Species Flow

Customer Training MaterialBoundary Conditions (inlet 1)
• Set boundary conditions
– Double click pressure_inlet from the Zone list.
– Apply Momentum and Thermal settings as shown– Apply Momentum and Thermal settings as shown.
– Continued on next page..
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WS3: Modelling Multi Species Flow

Customer Training MaterialBoundary Conditions (inlet 2)
• Set boundary conditions
– Apply Radiation and Species settings as shown.
– Click OK– Click OK.

WS3-21
ANSYS, Inc. Proprietary
© 2010 ANSYS, Inc.  All rights reserved.

Release 13.0
December 2010



WS3: Modelling Multi Species Flow

Customer Training MaterialBoundary Conditions (smoke release 1)
• Set boundary conditions
– Double click mass-flow-inlet-flue_gas from the Zone list.
– Apply Momentum and Thermal settings as shown– Apply Momentum and Thermal settings as shown.
– Continued on next page..
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WS3: Modelling Multi Species Flow

Customer Training MaterialBoundary Conditions (smoke release 2)
• Set boundary conditions
– Apply Species settings as shown.
– Click OK– Click OK.
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WS3: Modelling Multi Species Flow

Customer Training MaterialBoundary Conditions (walls 1)
• Set boundary conditions
– Double click wall from the Zone list.
– Apply Thermal settings as shown

The  Shell Conduction option  enables thin 
walls to solve for heat transfer in both the 

l d l di ti ith t th– Apply Thermal settings as shown.
– Click OK.

normal and planar directions without the 
need to volume mesh  them.
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WS3: Modelling Multi Species Flow

Customer Training MaterialBoundary Conditions (walls 2)
• Set boundary conditions
– Select Copy from the Boundary Conditions Pane.
– Select wall in the From Boundary Zone list and wall ceiling and– Select wall in the From Boundary Zone list and wall_ceiling and 

wall_floor in the To Boundary Zones list.
– Click Copy, click OK in the question dialog box then Close.

This will copy all boundary settings from the boundary zone wall to both wall ceiling– This will copy all boundary settings from the boundary zone wall to both wall_ceiling
and wall_floor.
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WS3: Modelling Multi Species Flow

Customer Training MaterialOperating Conditions
• Set operating conditions
– Select Operating Conditions.
– Apply Specified Operating Density settings as shown– Apply Specified Operating Density settings as shown.
– Click OK.
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WS3: Modelling Multi Species Flow

Customer Training MaterialOperating Conditions
• Notes

– ANSYS FLUENT avoids the problem of roundoff error by subtracting the operating 
pressure (generally a large pressure roughly equal to the average absolute pressure in 
th fl ) f th b l t d i th lt (t d th )the flow) from the absolute pressure, and using the result (termed the gauge pressure). 
The absolute pressure is simply the sum of the operating pressure and the gauge 
pressure.

– Operating temperature is only used when using the Boussinesq density model, so in this 
case, it has no meaning.

Operating density is also a value for avoiding roundoff errors For simulations where– Operating density is also a value for avoiding roundoff errors. For simulations where 
pressure boundary conditions are present it is important to set the value correctly 
otherwise the pressure at the boundary will be incorrect and may lead to unphysical flow 
conditions. Here you have to set it to the density for the conditions at the pressure-inlet -
a gas at 293 15 K with 23% O and 67% N You can initialize your flow field with thesea gas at 293.15 K with 23% O2 and 67% N2. You can initialize your flow field with these 
conditions to get the value for the operating density from the postprocessor (e. g. 
Reports -> Volume Integral). See the Users Guide “Natural Convection and Buoyancy-
Driven Flows” for more details.
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WS3: Modelling Multi Species Flow

Customer Training MaterialSolution Methods
• Set solution methods
– Select Solution Methods from the Navigation Pane.
– Under Spatial Discretization set Pressure to Body Force Weighted and– Under Spatial Discretization set Pressure  to Body Force Weighted and 

Energy to Second Order Upwind.
– The Body Force Weighted scheme is recommended for problems involving large 

body forces.
– The Second Order Upwind scheme is generally recommended for final solutions 

(first order is less accurate but numerically more stable and is often used for initial 
approximate solutions).
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WS3: Modelling Multi Species Flow

Customer Training MaterialSolution Controls
• Set solution controls
– Select Solution Controls from the Navigation 

Pane.Pane.
– Set Under-Relaxation Factors as listed below.

– Lower Under-Relaxation Factors will reduce the 
solution change between iterations leading to more 
stable convergence though requiring more iterations 
to reach convergence.

– Pressure = 0.3
– Density = 1
– Body Forces = 1
– Momentum = 0.7
– Turbulent Kinetic Energy = 0.5

T b l t Di i ti R t 0 5– Turbulent Dissipation Rate = 0.5
– Turbulent Viscosity = 0.7
– h2o = 1
– o2 = 1
– co2 = 1
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WS3: Modelling Multi Species Flow

Customer Training MaterialMonitors (1)
• Set solution monitors
– Select Monitors from the Navigation Pane.
– Click Edit and set the Residual Monitors as shown below– Click Edit and set the Residual Monitors as shown below.

– By default ANSYS FLUENT will plot residuals to the window and print to the console. The default setting for the 
convergence criterion is Absolute which means that the solver will continue until all residuals fall below the 
Absolute Criteria values specified in the Equations box. Switching the Convergence Criterion to none will cause 
the solver to continue until a maximum number of iterations is reached.  Click OK.
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WS3: Modelling Multi Species Flow

Customer Training MaterialMonitors (2)
• Set surface monitors
– Under Surface Monitors, click Create.

– Residuals monitor the numerical accuracy of the solution. However, it is equally important to ensure that 
solution variables have converged to sensible stable values. Creating Surface Monitors enables solution values 
of interest to be monitored on specific surfaces within the domain. Here, the mass flow rate will be monitored on 
the surface “interior_jet_in”. The monitor will be plotted to window 2 and printed to the console.    

– Set the Surface Monitor as shown below and click OK.
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WS3: Modelling Multi Species Flow

Customer Training MaterialMonitors (3)
• Set surface monitors
– Create another Surface Monitor.

– There are many different types of calculations that can be performed over surfaces listed under Report Type. 
This time we will monitor the integral of the Total Surface Heat Flux on the surface “wall_floor” plotting to 
window 3 and printing to the console. 

– Set the Surface Monitor as shown below and click OK.
– Created Surface Monitors are listed after creation.
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WS3: Modelling Multi Species Flow

Customer Training MaterialMonitors (3)
• Notes on monitors
− Buoyancy driven flows often show transient behavior. For this reason, 

the residuals often will oscillate. Because of this, convergence shouldthe residuals often will oscillate. Because of this, convergence should 
always be judged by solution variable monitors and flux reports. The 
residuals will however show overall for convergence behavior and 
stability.y

In cases of an oscillating steady state solution, a common approach is 
to continue the simulation in transient mode In many cases theto continue the simulation in transient mode. In many cases the 
oscillations will reduce significantly after a few time steps.

The use of surface/volume monitors combined with residuals willThe use of surface/volume monitors combined with residuals will 
provide the best overall judge of solution convergence. 
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WS3: Modelling Multi Species Flow

Customer Training MaterialSolution Initialization
• Set initialization values
– Select Solution Initialization from the Navigation Pane.

– The iterative process requires initial values for all solution variables. The default (standard) initialization method 
applies single values for each variable globally throughout the domain. These values should be within a 
reasonable range of what is expected in the domain. Specifying unrealistic values could cause convergence 
problems or require more iterations. Values can be specified manually or can be calculated from any or all 
boundaries using the Compute from option. 

– Specify the values manually as follows.

– Initial Values
– Gauge Pressure = 0
– X Velocity = 0X Velocity  0
– Y Velocity = 0
– Z Velocity = 0
– Turbulent Kinetic Energy = 0.01
– Turbulent Dissipation Rate = 0.01
– h2o = 0
– o2 = 0.23
– co2 = 0
– Temperature = 300
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WS3: Modelling Multi Species Flow

Customer Training MaterialCalculation Activities (1)
• Changing settings during the calculation
− Although simulations can often be run to convergence without 

adjusting the solver controls it is often beneficial to change theseadjusting the solver controls it is often beneficial to change these 
settings during the calculation. For example, some equations may not 
need as many iterations to converge. Also, in many thermal cases, it 
is advantageous in terms of solution stability to solve the momentum g y
equations first before switching on the energy equation. This step 
illustrates how to use the Case Modification panel to adjust solver 
settings during a calculation. 

− In this case we will first solve the full equation set for a small number 
of iterations, then only solve for mass/momentum before finally , y y
solving the full set again.
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WS3: Modelling Multi Species Flow

Customer Training MaterialCalculation Activities (2)
• Changing settings during the calculation

− Select Calculation Activities from the Navigation Pane, check 
the Automatically Initialize and Modify Case box and click Edit.

− Select the Case Modification tab.
− Using the defaults would result in the simulation being run 

using the existing settings (‘Original Settings’) for 1 iteration.
W ill b i i th i i l tti th l 2− We will be running using the original settings then apply 2 
modifications. Increase Defined Modifications to 2. 
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WS3: Modelling Multi Species Flow

Customer Training MaterialCalculation Activities (3)
• Changing settings during the calculation

− Commands are entered using the Text User Interface (TUI) syntax. Options selected using the 
Graphical User Interface (GUI) have equivalent TUI commands.

− Rather than type these out a journal file is provided for this workshop that will enter these for you.
− From the main menu, File>Read>Journal, Select the journal file “calc_activities.jou” from the user_files

directory. Answer No to the question dialog box asking if there are any read/write commands in the 
journal.

− Modification 1 will switch off all equations except the flow equations and run for 100 iterations.
− Modification 2 will switch all equations back on and run for 20 iterations.
− Set the Number of Iterations for Original Settings to 20.

Click OK and answer No to the question dialog box− Click OK and answer No to the question dialog box.
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WS3: Modelling Multi Species Flow

Customer Training MaterialCalculation Activities (4)
• Changing settings during the calculation
− The modifications now contain the TUI commands for switching various 

equations on and off. q
− For example, the TUI command for switching off the energy equation is of the 

form; (substituting n for y to switch on)
− /solve/set/equations temperature nq p

− The list of available TUI commands is extensive and goes beyond options 
available in the GUI. 

− All aspects of the solver can be controlled using TUI commands. g
− The journal used here contained the TUI commands to setup up the 2 case 

modifications. 

− Consult the documentation for a more comprehensive description of TUI 
command usage. 
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WS3: Modelling Multi Species Flow

Customer Training MaterialRun Calculation 
• Start the calculation
– Select Run Calculation from the Navigation Pane.

– The Number of Iterations is set to Automatic since this has been defined in the Case 
Modification panel.

– Before starting the calculation it is good practice to save the 
project.
– File>Save ProjectFile>Save Project.

– The calculation will take approximately 40 minutes in serial. 

– However if you are short of time, we have supplied a converged 
model that you can use instead (see next slide).
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WS3: Modelling Multi Species Flow

Customer Training MaterialReading in an Solution computed elsewhere
There are times when you may want to bring a solution (perhaps made on a remote 
cluster) into your workbench session.  

1. Stop the iterations. Close the existing FLUENT session, and return to Workbench
2. Drag a new FLUENT session into the Workbench page.  Rename as 

“Imported_Result”.
3. In the Setup Cell (B2), right click

d l t “I t FLUENT ”and select “Import FLUENT case”
Pick the file “workshop3-
converged.cas.gz”

4 FLUENT ill t t b t4. FLUENT will start up – be sure to 
select double precision.  Once 
open, close this session again.

5 I th S l ti ll (B3) i ht li k5. In the Solution cell (B3), right click 
and “Import Final Data”, selecting the
file “workshop3-converged.dat.gz”.

6 D bl li k th l ti ll (B3)
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and continue with this workshop.



WS3: Modelling Multi Species Flow

Customer Training MaterialCheck Residuals and Monitors (1)
• Check Monitors, Residuals and Fluxes

− If progressing from the pre solved project select Monitors from the Navigation Pane, click 
Edit under Residuals, Statistics and Force Monitors and click Plot in the Residual Monitors 
Panel that appears.

− The residuals are still quite high after 140 iterations and the surface monitors 
are still changing.
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WS3: Modelling Multi Species Flow

Customer Training MaterialCheck Residuals and Monitors (2)
• Check Monitors, Residuals and Fluxes
− Select Reports from the Navigation Pane and select 

Fluxes under Reports. Click Setup.p p
− In the Flux Reports panel check the Mass balance 

over all boundaries as shown below. Click compute.
− Note that the Net Results indicate a relatively large imbalance. 

Thi i i di ti th t th l ti i t f ll d N tThis is an indication that the solution is not fully converged. Net 
heat flux can be calculated in the same way. Close the panel.
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WS3: Modelling Multi Species Flow

Customer Training MaterialExit
• Close Fluent
− Close ANSYS FLUENT by selecting File>Close FLUENT

− ANSYS FLUENT contains basic built in post processing capabilities which can 
be used to quickly assess results graphically and numerically during and after 
the solutionthe solution.

− CFD POST is a powerful separate post processing application containing many 
more advanced features.  The remainder of this workshop will introduce some 
features of CFD POST.
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WS3: Modelling Multi Species Flow

Customer Training MaterialStarting CFD POST
• Add a Results System
− Drag a Results System onto the Solution cell of the FLUENT system.
− This will link a CFD POST (Results) system to the FLUENT system solutionThis will link a CFD POST (Results) system to the FLUENT system solution 

data as shown.
− Start CFD POST by double clicking on cell B2.

− This will start CFD POST and load the FLUENT solution data.
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WS3: Modelling Multi Species Flow

Customer Training MaterialPost Processing – Wall Temperature (1)
• Add a Location representing a group of surfaces 
− For displaying the temperature on all walls the most effective way is to use a 

surface group. g p
− Select Locations > Surface Group, enter a name as shown below and click OK.
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WS3: Modelling Multi Species Flow

Customer Training MaterialPost Processing – Wall Temperature (2)
• Define Location details
− The details of the new location 

will be displayed in the bottom left p y
pane.

− Select Locations, click on “…” and 
select all walls (CTRL click to 

lti l l t)multiple select).
− Click OK in the Location Selector.
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WS3: Modelling Multi Species Flow

Customer Training MaterialPostprocessing – Wall Temperature (3)
• Apply contour to Location
− Select the Color tab, click on Mode and select Variable  Temperature and click 

on Apply.pp y
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WS3: Modelling Multi Species Flow

Customer Training MaterialPostprocessing – Wall Temperature (4)
• Make changes to the legend
− If you want to change the appearance of the legend, select it in the tree (double 

click) and change the details accordingly – for example, set Precision to Fixed ) g g y p
instead of Scientific. 
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WS3: Modelling Multi Species Flow

Customer Training MaterialPostprocessing – Section Plane (1)
• Add a Location representing a section plane
− Select Locations > Isosurface, enter a name as shown below and click OK.

WS3-49
ANSYS, Inc. Proprietary
© 2010 ANSYS, Inc.  All rights reserved.

Release 13.0
December 2010



WS3: Modelling Multi Species Flow

Customer Training MaterialPostprocessing – Section Plane (2)
• Define Location details
− Under Geometry select Y as Variable and set the value to 9 m and set Color 

and Render as shown below.

− Click Apply. Switch off the previous Location (Walls) by unchecking it in the 
Outline.
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WS3: Modelling Multi Species Flow

Customer Training MaterialPostprocessing – 3d Isosurface
• Add a 3d Isosurface representing gases
− Use the same procedure - select Locations > Isosurface, enter a name (“Gas”) 

and click OK.
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WS3: Modelling Multi Species Flow

Customer Training MaterialPostprocessing – Streamlines (1)
• Add 3d streamlines to visualize flow
− Click the Streamline button                    and enter a name (“Streamlines”).

− Apply the Details as shown and click Apply.
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WS3: Modelling Multi Species Flow

Customer Training MaterialPostprocessing – Volume Rendering
• Add Volume Rendering
− Click the Volume Rendering button                     and enter a name (“Gas 

Volume”).)
− Apply the settings shown below under the Geometry tab, switch off the other 

Locations and click Apply.
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WS3: Modelling Multi Species Flow

Customer Training MaterialSave and Close
• Other Features
− There are many other features available in CFD POST

− AnimationsAnimations
− Expressions & Functions
− Charts & Tables

Automatic Report Generation− Automatic Report Generation
− Multiple Case Comparison

− Close CFD POST (File > Quit) and save the project from the Workbench Project 
Page.
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